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Appraisal Process – A systematic and orderly approach by 
which the problem of real estate valuation is defined; the 
work necessary to solve the problem is planned; and the 
data involved is acquired, classified, analyzed and 
interpreted into an estimate of value.

Approaches to Value – The traditional methods or 
techniques by which market data may be processed into an 
indication of value. The three approaches to value include 
the; Cost Approach, Income Approach, and the Market 
Approach.
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Cost Approach - Historical cost should be the cost of the property when first 
put into service.  Appraisers should inspect the balance sheet and subsidiary 
deprecation schedules of the centrally assessed company to ensure that the 
historical costs of all unitary property has been included.  This is the reason that 
historical cost is sometimes referred as book cost. When possible, seek 
historical costs that come from independently audited financials.  

ABC Pizza
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Income Approach – Is the value 
that may be described as any 
method that converts future 
anticipated income into present 
value. 
• Premised on the assumptions 

that investors buy and sell 
property based on the income it 
is expected to yield and that 
investors discount expected 
income at its attendant risk rate 
over its anticipated duration.

• For appraisal purposes, income 
is the anticipated net benefits a 
property will provide to its 
owners or users over time.

ABC Pizza
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Market Approach – Stock and 
Debt - The conceptual basis for the
stock and debt indicator is that the total 
value of a firm’s assets is equal to the 
total value of its liabilities and 
stockholders’ equity. 
• Firms purchase assets using equity or

debt financing. Purchases of assets
from internal cash flows are usually
considered a contribution from existing
shareholders.

• For firms that have publicly traded
securities (stocks and bonds), market
prices can be obtained for sales of
fractional portions of these debt and
equity securities.

• Accordingly, the market prices can be
applied to the total group of securities
to obtain the market value of the firms’
assets.

ABC Pizza
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Unit Market Value – The Whole Company
• $ 26,200,000 – Determined from

the three Approaches to Value.

Allocation to Missouri
• $ 26,200,000  x 97.31870% = $ 25,497,499
• The Allocation Percentage comes from 12 CSR 30-2.016.
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State – Market Approach

State – Income Approach

State – Cost Approach

Local – Operating Property

Local – Construction Work in Progress

Local – Tangible Personal Property 8



Remove Locally Assessed Operating Property
• $25,497,499 - $3,925,914 = $21,571,585

(Missouri Distributable Market Value)
Examples of Locally Assessed Property:

1. Buildings and Land associated with local property
2. Office furniture, equipment and fixtures
3. Motor Vehicles
4. Materials and supplies
5. Construction-work-in-progress (CWIP)

Locally Assessed property is NOT used in the movement of services. 

Missouri Statutes define Locally Assessed Real Property and Tangible Personal 
Property of Railroad and Utility Companies. The statutory references are: RSMo
151.020.3, 153.032.2, 153.034.2, and 153.036.2, Revised Statutes of Missouri.
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Local – Operating Property

Local – Construction Work in Progress

Local – Tangible Personal Property

State – Market Approach

State – Income Approach

State – Cost Approach
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STATE PIZZA

State – Market Approach

State – Income Approach

State – Cost Approach

11



Slice the Missouri Distributable Market Value into Real Market Value and Personal Market Value

• Real Market Value; 
$21,571,585 x 59.77% = $12,893,336 

• $12,893,336 x 32% = $4,125,868 (Assessed 
Value Real)

• Personal Market Value; 
$21,571,585 x 40.23% = $8,678,249 

• $8,678,249 x 33.33% = $2,892,750 (Assessed 
Value Personal)

• $4,125,868 + $2,892,750 = $7,018,618 
(Total Missouri Assessed Value)
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County Assessed Value 
(Distributable Assessed Value for Missouri County)

• Total Missouri Assessed Value x County Mileage 
Percentage (County miles / State miles)

• $7,018,618 x 2.47768% = $173,899

Slice the Missouri Assessed Value per Mile and the Distributable Assessed Value for each Missouri County
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Unit Market Value
• $26,200,000

Allocation to Missouri
• $ 26,200,000  x 97.31870% = $ 25,497,499

Remove Locally Assessed Operating Property
• $25,497,499 - $3,925,914 = $21,571,585 (Missouri Distributable Market Value)

Split the Missouri Distributable Market Value into Real Market Value and Personal Market Value

• Real Market Value; $21,571,585 x 59.77% = $12,893,336
• $12,893,336 x 32% = $4,125,868 (Assessed Value Real)

• Personal Market Value; $21,571,585 x 40.23% = $8,678,249
• $8,678,249 x 33.33% = $2,892,750 (Assessed Value Personal)

• $4,125,868 + $2,892,750 = $7,018,618 (Total Missouri Assessed Value)

County Apportionment (Missouri Assessed Value per Mile)
• Total Missouri Assessed Value / Total Missouri Miles
• $7,018,618 / 799.94 = $8,774 per mile

County Assessed Value (Distributable Assessed Value for Missouri County)
• Total Missouri Assessed Value x County Mileage Percentage (County miles / State miles)
• $7,018,618 x 2.47768% = $173,899 apportioned to county



ABC Pizza

26 Cole
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The Schedule 14 Page 2 is submitted only 
once by the Company when they submit 
the original Locally Assessed Property 
Schedules to the County Assessor.

The Company provides their contact 
information at the bottom of the 
Schedule 14 Page 2 for the County 
Assessor’s use. 

State Tax Commission Locally Assessed Property Schedules
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The locally assessed property schedules have been incorporated into an Excel workbook.  
The Excel workbook consists of six worksheets.  The company must submit locally 
assessed property schedules to the County Assessor by April 1.  

State Tax Commission Locally Assessed Property Schedules

The Original Assessment Section can create the local property schedules in an expanded 
Excel workbook for a County Assessor that needs multiple pages for a company.  Contact 
Stacey Cowan at 573-751-1708 or stacey.cowan@stc.mo.gov.

FILING REQUIREMENTS (Sections; 151.020.1(3), 153.032.2, 153.034.2, 153.036.2 RSMo)
_______________________________________________________________________________________

• The company must submit copies of Schedule 14 – Page 1 & Page 2, Schedule 15NP & 15OP, Schedule 16, 
CWIP Real, and Tangible Personal Property on or before April 1.

• The Assessor must send a signed copy of Schedule 14 – Page 1 & Page 2, Schedule 15NP & 15OP, 
Schedule 16, CWIP Real, and Tangible Personal Property to the Company, County Clerk, and the State Tax 
Commission of Missouri on or before April 20.
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ABC Company, Inc.

ABC Company, Inc.
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ABC Company, Inc.

ABC Company, Inc.
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ABC Company, Inc.

ABC Company, Inc.
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ABC Company, Inc.

ABC Company, Inc.
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ABC Company, Inc.

ABC Company, Inc.
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ABC Company, Inc.

ABC Company, Inc.
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ABC Company, Inc.

Line 17: The Company enters the Original Cost for 
“New Construction and Improvements” (NCI) on 
Schedule 14 Page 1, Line 17, to identify that NCI 
existed on January 1. 

Land can never be considered NCI. 

The Company provides supporting documentation 
with the Locally Assessed Property Schedules to 
identify the amount of Original Cost of NCI in each of 
Line 1, Line 3, and Line 13.  

The supporting documentation should describe the 
Company location information for each entry, 
including the applicable school district and other 
taxing jurisdictions. 
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Line 18: The Company checks the box if they have no 
miles of line in the county but have local property 
such as vehicles.

County Clerk: cross reference Line 18 to Schedule 
13s to confirm that no Schedule 13 was filed.

Line 19 and Line 20: The County Assessor uses the 
“Filing Submitted by: Assessor” checkbox on Line 19 
and the “Filing Tracker: Original Submission” 
checkbox on Line 20, to indicate this is the 
Company’s original filing to the County Assessor; the 
County Assessor uses the filing checkboxes on Line 
19 and 20 when there is a Resubmission filing; refer 
to page 4 of the Original Assessment Resource 
Manual for more details.

ABC Company, Inc.
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State Tax Commission Schedule 13

• Schedule 13 provides miles of line located in each taxing jurisdiction, except school districts, for all Missouri 
Counties. 

• Original Assessment (OA) sends each centrally assessed company a company-specific Schedule 13 with 
miles of line reported to the Commission from the prior tax year. 

• The company updates the Schedule 13 with any new miles of line to exactly two decimal places (one-hundredth 
of a mile).

• All taxing jurisdictions, active as of January 1, are listed for each county.  New entries for miles of line, by 
county, should be appropriately identified for the current tax year.  

• Companies should not send the Schedule 13 to a county with no miles of line. 

• The Schedule 13 must be submitted to OA and applicable counties by April 15. 
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2022

2022 Miles 2022 Miles Updated

• Schedule 13s have five types of  taxing jurisdictions: 
County Wide, Municipality, Special, Road, and 
Township. 

• Miles entered in the “2022 Miles” Column are the miles 
certified in the prior tax year.  Miles entered in the “2022 
Miles Updated” Column are the Company’s updated 
miles, if any, for the current tax year. 

• Companies only update miles in the “2022 Miles 
Updated” if miles changed from the prior year.

• If there is no change then the “2022 Miles Updated” 
column remains blank.

• If an Amendment takes place, the company and clerk 
must send an amended Schedule 13 to each other and 
OA.

ABC Company, Inc.
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2022

2022 Miles 2022 Miles Updated

• OA updates the “Taxing Jurisdictions by County” on the 
Schedule 13 in December each year.

• Clerks are responsible for adding new taxing 
jurisdictions at the bottom of Schedule 13, and notifying 
companies. OA uses this information, along with the 
State Auditor’s report, to update the Schedule 13 each 
December. 

• Any discrepancies noted on the Schedule 13 by the 
Clerk should be discussed with the company 
immediately upon receipt.

XYZ Township Linn County 1.00

ABC Company, Inc.
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State Tax Commission Form 40

• Clerks prepare the Form 40 with data from the certified Schedule 14s received 
from the Assessor.

• The Form 40, with the county clerk’s signature, date, and the county’s seal 
affixed, is the county clerk’s certification for each company’s miles of line in the 
county taxing jurisdictions, excluding school districts. (Section 151.040 RSMo).  

• The Form 40 and the associated Schedule 13 for each centrally assessed 
company must be certified and submitted by the county clerk to the Original 
Assessment Section (Section 151.040 RSMo) by May 15.

• The Form 40 assessed values are used as a reconciliation tool for the Original 
Assessment Section and the Administration Section in conjunction with the 
Form 11/11A.
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Navigate to Form 40
To navigate to the Form 40 on the STC’s website, Select the tab for the “Clerks” section and 
then the “Commonly Used Forms” link.
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Navigate to Form 40
Under the “Commonly Used Forms” banner, select the “2022 – Form 40_All Counties” link (third 
section down from the top).
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Navigate to Form 40
Download and open the “2022 – Form 40_All Counties” Excel workbook then select and 
save appropriate county worksheet. 
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Save Form 40 By County

9

• Right click applicable County tab 

• Select “Move or Copy” and box pictured 
to the right will appear

• Select the “Create a copy” checkbox

• Click the “To book:” dropdown

• Select “(new book)” 

• Click “OK”
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Save Form 40 By County
After clicking “OK” the applicable County tab will now stand alone in its own Excel workbook. 
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Form 40 Data Placement
• Form 40 data comes from the 

Assessor certified Schedule 14, 
page 1.

• Take REAL Operating Property, 
Line 4 of Assessed Value and 
report on the Form 40 under Real 
Property, highlighted in Red.

• Take TANGIBLE PERSONAL 
Operating Property, Line 11 of 
Assessed Value and report on 
the Form 40 under Personal 
Property, highlighted in Green.

• Take TOTAL OPERATING 
PROPERTY, Line 12 of Assessed 
Value and report on the Form 40 
under Total Assessed Value, 
highlighted in Blue.

DO NOT INCLUDE NON-OPERATING PROPERTY REPORTED ON FORM 40  



ABC Company, Inc.

ABC Company, Inc.
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How to Digitally Sign the Form 40
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Stacey A. Cowan

YOUR TEXT HERE

• Click the “Insert” tab, then the “Text Box” icon, and a “Your Text Here” box will appear

• Type your “Name” in the “Text Box”, then drag and drop the “Text Box” with “Name” to appropriate location
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Stacey A. Cowan

05-15-2022Stacey A. Cowan

• Type “Name” in the “Signature of County Clerk” text field

• Type “Date” in the “Date” text field

• You may change font, size, or color if desired

How to Digitally Sign the Form 40, cont.



How to Affix County Seal to the Form 40
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• Find County Seal
• Google
• Your website
• In your office

• Save image to your desktop
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• Click the “Insert” tab, then the “Pictures” icon, and an “Insert Picture” box will appear

• Navigate to saved image location, i.e.; “Desktop”, and select “Seal Image”, then click the “Insert” button

How to Affix County Seal to Form 40, cont.



How to Affix County Seal to Form 40, cont.
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Stacey A. Cowan

Stacey A. Cowan

• County Seal will appear. You may change size and move to desired location

• E-signature Block is now complete, with; “Text Box” name, “Typed” Signature & Date, and Picture Insert of 
County Seal

05-15-2022



Ways to Send the Form 40 and Schedule 13s to OA
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Combine the Form 40 Excel worksheet with all the Schedule 13 Excel worksheets and send to 
OA in one Excel workbook. – PREFERRED1.

Subject: Must include; 
• Year
• County Name
• Contents being sent

Attachment: Must include; 
• Year
• County Name
• Form or Schedule Name

Send to; 
originalassessment@stc.mo.gov
or via FTP in same format 

mailto:originalassessment@stc.mo.gov


How to Save Form 40 and Schedule 13s in One Workbook

19

• Open Form 40 Excel 
workbook

• Move company Schedule 13s 
to the Form 40 Excel 
workbook

• Save each company Schedule 
13 in the Form 40 Excel 
workbook in the same order 
as the Form 40

• Double click the company 
Schedule 13 tab to rename 
with company account number



How to Save Form 40 and Sch. 13s in One Workbook cont.
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• Open Schedule 13s one at a time to 
move and save to the “Form 40 and 
Schedule 13” Excel workbook

• Once the company Schedule 13 is 
open, right click the tab at the bottom

• Select “Move or Copy” and box 
pictured to the right will appear

• Select the “Create a copy” checkbox

• Click the “To book:” dropdown

• Select “Form 40 and Schedule 13 
Excel Workbook”

• Click “(move to end)” and click “OK”



How to Save Form 40 and Sch. 13s in One Workbook cont.
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• Once all Schedule 13s are 
moved to the Form 40 and 
Schedule 13s Excel workbook

• Save and send via email as one 
attachment to: 
originalassessment@stc.mo.gov

mailto:originalassessment@stc.mo.gov


Ways to Send the Form 40 and Schedule 13s to OA
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Modify Excel worksheet with adequate Print Selection, save as PDF, and send to OA as 
individual PDFs.2.
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• From the “View” tab, click “Page Break 
Preview”.

• Blue dotted lines will appear, indicating 
the print page.

• Move “Rows” and “Columns” within the 
blue dotted print lines as needed.

• Simply drag and drop blue dotted line to 
desired location.

Modify Excel Worksheet Print Selection & Save as PDF
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Modify Excel Worksheet Print Selection & Save as PDF, cont.
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• Line 17 “North Stone County-Northeast 
Barry County FPD” of the Schedule 13 
will now print to Page 1.

• Page Breaks can go up and down, or left 
and right.

• Once this is complete, everything moved 
within the blue dotted lines, will print to 
chosen page.

Modify Excel Worksheet Print Selection & Save as PDF, cont.



26

Modify Excel Worksheet Print Selection & Save as PDF, cont.



27

• Note – Ensure that print area is set up 
in Excel before saving to PDF

• Click the “File” tab and select “Save as 
Adobe PDF”

• Select the “Sheet(s)” button under 
“Conversion Range”

• Select the “Fit to paper width” button 
under “Conversion Options”

• Click “Convert to PDF”

• Error message may appear, click “Yes”

Modify Excel Worksheet Print Selection & Save as PDF, cont.
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• Type, 2022 Form 40 – Adair County 
in the “File Name” text box

• Select Location you wish to save, i.e.; 
Desktop

• Click the “Save” button

• Send via email as individual PDF 
attachment to: 
originalassessment@stc.mo.gov

Modify Excel Worksheet Print Selection & Save as PDF, cont.

mailto:originalassessment@stc.mo.gov


Ways to Send the Form 40 and Schedule 13s to OA
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Combine the Form 40 and Schedule 13s in One PDF Attachment Using Adobe Acrobat.3.

Subject: Must include; 
• Year
• County Name
• Contents being sent

Attachment: Must include; 
• Year
• County Name
• Form or Schedule Name

Send to; 
originalassessment@stc.mo.gov
or via FTP in same format 

mailto:originalassessment@stc.mo.gov


How to Combine the Form 40 and Schedule 13s in 
One PDF Attachment Using Adobe Acrobat

30

• Open Acrobat to combine files; Open the Tools tab 
and select “Combine files”

• Add files; Click “Add Files” and select the files you 
want to include

• You can merge PDFs or a mix of PDF documents

• Arrange and delete content; Click, drag, and drop to 
reorder files or press “Delete” to remove any content 
you don’t want

• Combine files; When you are finished adding and 
arranging, click “Combine Files”

• Save as a PDF file; Name your file and click the 
“Save” button



How to Combine the Form 40 and Schedule 13s in 
One PDF Attachment Using Adobe Acrobat

31



How to Combine the Form 40 and Schedule 13s in 
One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 
One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 
One PDF Attachment Using Adobe Acrobat
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How to Combine the Form 40 and Schedule 13s in 
One PDF Attachment Using Adobe Acrobat

35

• Type, 2022_Adair County_Form 40 
and Schedule 13 in the “File Name” 
text box

• Select Location you wish to save, i.e.; 
Desktop

• Click the “Save” button

• Send via email as individual PDF 
attachment to: 
originalassessment@stc.mo.gov

mailto:originalassessment@stc.mo.gov


Ways to Send the Form 40 and Schedule 13s to OA
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Combine the Form 40 with all the Schedule 13s and send to OA in one scanned PDF.

ORGANIZE Schedule 13s in the same order as the Form 40 list of companies.4.

Subject: Must include; 
• Year
• County Name
• Contents being sent

Attachment: Must include; 
• Year
• County Name
• Form or Schedule Name

Send to; 
originalassessment@stc.mo.gov
or via FTP in same format 

mailto:originalassessment@stc.mo.gov


How to Send the Form 40 and Schedule 13s to OA
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• When scanning the Form 40 and Schedule 13s in one document/attachment, sequence the 
Schedule 13s per the Form 40 list order.



Things to Double Check Before Sending the Form 
40 and Schedule 13s to OA

38

• Do the figures on the Form 40 match the Assessed Value per the Schedule 14

• Is there an “X” on the Form 40 for companies with a Schedule 13

• Is the Signature Block complete

• Does the Subject Line in the email include; Year, County Name, and items enclosed

• Do the attachments enclosed in the email include; Year, County Name, and Form or Schedule 
name

• Are all the Schedule 13s included with the Form 40 submission

• Be sure to send the Final Schedule 13 to OA with the Form 40 submission

• Contact company with any questions, concerns, or missing items
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Navigate to the Certification
To navigate to the Certification on the STC’s website, Select the tab for the “Clerks” section 
and then the “Certifications” link

2



Certification by Tax Year and by County
Under the “Certifications by Tax Year” banner, select the “Certifications by: County” link
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Searching by County and Tax Year
Under the “County Certifications” banner, select the current tax year from the “Tax Year” drop down menu, 
enter the county’s name or the county’s number in the “County”  text box, and then select the “Search” 
button 

2022
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Viewing the County Certification Report
Select the “View” link for the “County” entry to view the report 

2022

06/18/2022

06/13/2022

YES
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County Certification Report
You may “Save” the pdf document to your computer, or “Print”  the report  

2022
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State Tax Commission Certification
• The County Clerk should check the STC website each month after 

certification to check for amended certifications.

• The STC sends an automated notification to the County Clerk’s 
Missouri Secretary of State (SOS) email address with instructions 
to review certification and amended certification on the STC’s 
website at https://stc.mo.gov.

• The Original Assessment Section uses preferred email addresses 
for other correspondence throughout the year.  
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= $4,174.31 Assessed Value per mile÷
ABC Company, Inc.
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9Contact Stacey Cowan at: stacey.cowan@stc.mo.gov

Certification Data in an Expanded Excel Workbook

mailto:stacey.cowan@stc.mo.gov




State Tax Commission Commercial Aircraft
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• “Commercial aircraft” is defined as an aircraft fully equipped for flight and of more 
than 3,000 pounds maximum gross take-off weight (Section 155.010 RSMo).  

• There are two categories of commercial aircraft:
• Commercial aircraft owned by others (CAOBO – account 120) and are NOT

engaged in the carriage of persons or cargo for hire. 
• Commercial aircraft owned by airlines (CAOBA – account 130) and are engaged in 

the carriage persons or cargo for hire. 

• The allocation to Missouri is based on total miles flown in Missouri to total system 
miles flown in the prior year (Section 155.040 RSMo).

State Tax Commission Commercial Aircraft

2



• CAOBA are required to be assessed by the State Tax Commission and must complete 
the following steps:
• Submit a required Aggregate Statement of Taxable Property to the Original 

Assessment Section on or before May 1.  This includes the Form 12 and associated 
schedules.

• CAOBA includes medical helicopters meeting the commercial aircraft definition.

• CAOBA Tax Situs
• For CAOBA entities, the taxing situs is the location of arrivals and departures at 

airports and/or helicopter pads

Commercial Aircraft Owned By Airlines (CAOBA)

3



• Filing CAOBO is not a requirement – CAOBO can file to be locally assessed or centrally 
assessed. If central assessment is chosen the following steps must be completed:
• File a personal property declaration with the County Assessor by March 1 and 

submit a commercial aircraft claim with the County Assessor; and,
• Submit a required Aggregate Statement of Taxable Property to the Original 

Assessment Section by May 1.  This includes the Form 12 and associated schedules.

• CAOBO Tax Situs
• Aircraft owned by individuals taxing situs is the county where the individual resides. 
• Aircraft owned by entities other than individuals taxing situs is the aircraft's airport 

location.

• By May 1 of each year, the county assessor shall provide the State Tax Commission (STC) 
with any information compiled from personal property lists filed with the assessor 
necessary for the STC to assess aircraft (RSMo. Section 155.040).

Commercial Aircraft Owned By Others (CAOBO)
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• The current Federal Aviation Administration (FAA) aircraft list for each county in 
Missouri is available online on the State Tax Commission’s website.

• The Original Assessment Section will provide additional aircraft information to the 
County Clerk after Certification of commercial aircraft, to identify tax situs.

• Taxing jurisdictions are not identified on the State Tax Commission's commercial 
aircraft certification. 

State Tax Commission Commercial Aircraft
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Navigate to the Local Schedules
To navigate to the Local Schedules on the STC’s website, select the tab for the “Assessor” 
section and then the “Local Schedules” link.

2



Navigate to the Local Schedules

3



Navigate to the Educational Resources
To navigate to the Educational Resources on the STC’s website, select the tab for the “Assessor” section, the 
“Clerks” section, or the “Railroad & Utilities” section and then the “Educational Resources” link.
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Navigate to the 
Educational Resources
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Navigate to the 
File Transfer Protocol 
(FTP)
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Navigate to the Company Resources
To navigate to the Company Resources on the STC’s website, select the tab for the “Railroad & Utilities” 
section and then the “Industry” link.
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Navigate to Company Resources
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Navigate to the Form 40
To navigate to the Certification on the STC’s website, select the tab for the “Clerks” section 
and then the “Commonly Used Forms” link.
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Navigate to the Form 40
Under the “Commonly Used Forms” banner, select the “2022 – Form 40_All Counties” line (third 
section down from the top).

10



Navigate to the Form 40
Download and open the “2022 – Form 40_All Counties” Excel workbook then select and 
save appropriate county worksheet. 
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Navigate to the Certification
To navigate to the Certification on the STC’s website, Select the tab for the “Clerks” section 
and then the “Certifications” link.

12



Certification by Tax Year and by County
Under the “Certifications by Tax Year” banner, select the “Certifications by: County” link.
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Searching by County and Tax Year
Under the “County Certifications” banner, select the current tax year from the “Tax Year” drop down menu, 
enter the county’s name or the county’s number in the “County”  text box, and then select the “Search” 
button. 

2022
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Viewing the County Certification Report
Select the “View” link for the “County” entry to view the report. 

2022

06/18/2022

06/13/2022

YES
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County Certification Report
You may “Save” the pdf document to your computer, or “Print”  the report.  

2022
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Navigate to the Taxing Jurisdictions by County 
and School Taxing Jurisdictions by County
To navigate to the Taxing Jurisdictions by County and School Taxing Jurisdictions by County 
on the STC’s website, select the tab for the “Clerks” section and then the “Certifications” link.

17
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Navigate to the Taxing Jurisdictions by County 
and School Taxing Jurisdictions by County
Under the “Taxing Jurisdictions by County” banner, select the “Taxing Jurisdictions by 
County or School Taxing Jurisdictions by County” link(s).



Navigate to the FAA County Aircraft List
To navigate to the FAA County Aircraft List on the STC’s website, select the tab for the 
“Assessor” section and then the “FAA County Aircraft List” link.
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Navigate to the FAA County Aircraft List
Under the “FAA County Aircraft List” banner, select the “2022 FAA County Aircraft List” link.

20



State Tax Commission - Original Assessment

For additional assistance contact:
• Stacey Cowan, Appraisal Specialist – 573-751-1708

• Peter Chari, Appraisal Specialist – 573-751-1729
• Jeffrey Smith, Manager – 573-526-6403
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